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Chapter 1

Product Overview
SDLTrados Studio is a CAT tool and translation memory software that helps you translate

and manage translation projects faster and easier.

Studio offers a complete environment for professional translators to edit and review

projects, use agreed terminology and leverage machine translation results. As a project

manager, you can use Studio to effectively manage all aspects of translation projects.

See the Studio online Help for information on using Studio.

OpenExchange apps

You can extend and enhance the default functionality of your Studio version through

OpenExchange plug-ins. OpenExchange is the SDL app store where you can:

■ download apps which extend the Studio functionality

■ join the SDL OpenExchange Developer Program, if you are a developer

interested in creating new Studio apps

Freelancer and Starter versions

The Freelance and Starter versions of Studio cannot run on a domain-based network.

This is the intended behavior for these two versions. If you want to run Studio on a

domain-based network, use the Express, Professional or the Studio Workgroup

version instead.

See the Studio comparison table for more information on the differences between the

Studio editions.

Product names

For better readability, this document uses the short names for the following SDL

products:

■ SDL Trados Studio - Studio

■ SDL Studio GroupShare - GroupShare

■ SDLMultiTerm - MultiTerm
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Chapter 2

What's new in SDL Trados Studio
2015?

This section provides an overview of the new features, enhancements and other changes

introduced in Studio 2015 including Service Releases.

Changes introduced in Studio 2015 SR2
This is a list of new features and functionality that were introduced in this release.

Introduced SDL Terminology Provider API

The Terminology Provider API allows developers to create custom integrations and

access third-party terminology providers directly from Studio.

This is similar to the currently available capability that allows users to create custom

translation providers with the SDL Translation Memory API.

Enhanced Termbase Settings UI

To accommodate the possibilities offered by the new Terminology Provider API, the

Termbase Settings user interface in the Project Settings has been refreshed.

The new user interface for adding terminology resources resembles the one for Translation

Memory and Automated Translation and is now ready for plugging in third-party

terminology apps.

The new user controls allow you to add MultiTerm files or server-based termbases as

before, but you can now also create new file-based termbases from within Studio.

Accessing Termbase Settings > Create > New File-based Termbase

opens the MultiTerm Termbase Wizard. This way, you can create new, empty termbases

as part of creating the project. For any additional tasks such as importing or exporting

terminology from within Studio, we recommend using the Glossary Plugin or the

standalone SDLMultiTerm application.
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Add to terminology from concordance results

You can now add new terms to your termbase straight from the Concordance Search

Window.

To do this, you select a source and a target string from the concordance results, then click

on one of the newly added buttons from the Concordance Search Window:

■ Add New Term - if you want to add the term and open the Edit Term mode in

the Termbase Viewer window - this will allow you to fill all the available

termbase fields and review the new term before adding it to the termbase.

■ Quick Add New Term - if you want to directly add the term as is.

Introduced SDL Batch Task API

You are now able to fit custom batch tasks in more flexibly with your supply chain and

work processes.

The Batch Task API allows developers to plug in their own pre- and post-processing

tasks.

New Work in Progress (WIP) Report batch task

Leveraging on the new Batch Task API, there is a new WIP Report batch task that gives

translators and PMs a more accurate picture of which tasks are required to complete a

project.

The WIP Report batch task provides a summary of the current contents and status of

segments in an SDLXLIFF file without any lookups in TMs. Based on the confirmation

level of each segment, the report also shows which tasks are to be performed on each

category, such as Post-Editing for machine-translated draft segments or Review for any

translated segments.

Enhanced licensing to support multiple editions
and add-ins

It is now possible to run multiple product editions on the same network license server.

For example, you can connect Studio to a Professional orWorkgroup license from the same

network license server if those licenses are activated on that server.

If that is the case, the Product Activation window in Studio displays a new dialog box

that allows you to select from multiple product editions.

There is also an optional settings file that gives you control over which editions can be

checked out by the user. For more information on this, go to the Configure Available

Product Editions help page.

What's new in SDL Trados Studio 2015?
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Enhancements to the Microsoft Word (2007-2016)
file type

The new Microsoft Word (2007-2016) file type has reached maturity and is now the

default against the legacy Word (2007-2013) file type. When using the new file type, you

can now keep track of your progress with the real-time preview, regardless of your

version of Microsoft Office.

These enhancements to the Microsoft Word (2007-2016) file type were made for the SR2

release:

■ New real-time preview in separate application window to support Microsoft

Office Click-to-Run versions (e.g. Office 365).

■ The new embedded HTML-based preview is now fully available.

■ The preview types naming has been improved:

■ Embedded refers to the legacy real-time preview

■ Microsoft Word refers to the new external real-time preview

■ HTML refers to the new HTML-based preview.

■ The new Microsoft Word (2007-2016) file type has been moved to be listed above

the legacy Word (2007-2013) file type in the default order of file types. This

helps ensure that the new file type is used for new projects instead of the legacy

one. We recommend using the new file type wherever possible.

■ The PDF file type also uses the new Word (2007-2016) file type as its output

format.

■ The default value for the alternative text setting has been changed so that such

text is not extracted by default.

Enhanced the project package handling

Some additions to the way project packages are handled were made to customize process.

The Open Package wizard is now more flexible, in the sense that you can now choose

whether or not you wish to add the project name to the folder by default. On the Review

Package Contents page of the wizard, enable or disable the Append project name to

project folder option for this.

On the same wizard page, you can choose whether or not to save packages to the Studio

default project location or a custom one with the Use default Studio project location

option.

What's new in SDL Trados Studio 2015?
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Enforce verification checks before package return

When creating a project package, you now have the option to enforce the assigned user to

perform verification checks before they create the returning package.

This is to ensure that less experienced Studio users return an error-free project package.

You can find the new User must run verification before returning the package option

on the last page of the Create Project Package wizard.

A corresponding flag has also been added to the SDL Project Automation API so that

developers of third-party systems can make use of this new feature and flow.

Added option to insert TM match in merged
segments

When merging segments, you now have the option to automatically update the content in

target segments, if a better match is found in the TM for the merged segment.

This new option was introduced under

File > Options > Editor > Automation.

Added support for QuarkXPress 2015 files

The QuarkXPress file type can now support QuarkXPress 2015 files.

Changes introduced in Studio 2015 SR1
This is a list of new features and functionality that were introduced in this release.

Added new option for TM update batch tasks and
exposed all options in TM API

Until now, you either had to add all translation units (TUs) as new TUs, thus keeping

unwanted duplicates where you fixed spelling mistakes, or overwrite all existing TUs,

which lead to deleting duplicates that have been explicitly added by the translator using

the Add as New Translation command. With the Merge translation units option, you

now have the flexibility to incorporate both options in one single batch task. This also

allows you to merge any metadata associated with the TUs during the batch task.

All the new update TM options are now fully exposed in the TMAPI.

What's new in SDL Trados Studio 2015?
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Added support for Microsoft Office 2016 files to
all Microsoft file types

All Microsoft file types (Microsoft Word 2007-2013, Microsoft Excel 2007-2013 and

Microsoft PowerPoint 2007-2013) as well as the bilingual Workbench file type have been

enhanced to support files created in Microsoft Office 2016.

Improved Language Cloud Wizard experience

The SDL Language CloudWizard that is displayed on SDLTrados Studio startup has been

enhanced to provide easier access to SDL Language Cloud Machine Translation.

Also, the API key for Language Cloud no longer needs to be entered every time after

starting Studio.

Localised user interface and other UI related
enhancements

All localised user interface languages are refreshed and support the new features.

The Welcome page now contains the Spanish Quick Start Guides and features more

videos related to SDL Trados Studio 2015, SDLMultiTerm 2015 SR2 and SDL Studio

GroupShare 2015.

Changes introduced in Studio 2015
This is a list of new features and functionality that were introduced in this release.

Translation Quality Assessment for custom
quality analysis

Use the new Translation Quality Assessment feature in Studio 2015 to measure the

quality of a translation using custom quality criteria.

What's new in SDL Trados Studio 2015?
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Set up a TQA framework by choosing the quality metrics that matter most to you and

weighing their importance. This framework guides the reviewers when evaluating

translations and enables Studio to determine the quality of a translation automatically.

Translation issues are distributed into preset categories and can take different severities.

These categories and severities have penalty points associated to them. Studio adds up the

penalty points to give you a detailed report on the document's quality.

The Studio 2015 Service Release 1 brings a handful of improvements to the Translation

Quality Assessment feature. Overall, the usability and functionality has been enhanced,

especially when it comes to adding and editing TQA items in a document. The feature

has also been improved so that:

■ you can now export and import TQA configurations

■ TQA report now gives you a visual representation of additions or deletions in the

changed segments

■ it is now possible to create a severity with 0 penalty points to indicate, for instance,

repetitions of errors that should not count towards the total penalty point count

■ you can also associate a target text fragment with its corresponding source text

fragment when adding or editing a TQA item.

Update project files with changes made to a target
file during review

With the Retrofit feature, you can import any changes made by an external reviewer to a

previously exported native file back into your Studio project. There is a new Update from

Reviewed Target File (Retrofit) batch task that you can use for this.

After the changes are imported, you can review the updates in the Editor view using

tracked changes. Optionally, you can also check and correct the Retrofit results in

Alignment view before opening them in the Editor.

AutoCorrect spelling or easily insert frequently
used text and symbols

You can now use the AutoCorrect feature to automatically replace misspelled words and

typos from a default set of terms. You can modify the list of terms to suit your own needs.

The AutoCorrect settings are applied in the Studio Editor, as you type. Studio uses the

replacement list for the project's target language to make the corrections. You can also set

up shortcuts in the replacement list to speed up typing of certain words or phrases or to

insert symbols.

To access the settings for autocorrection, select File > Options and find them under

Editor > AutoCorrect.

What's new in SDL Trados Studio 2015?
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Extend AutoSuggest to every kind of match

You can now extend the AutoSuggest feature in Studio to new match types:

■ translation memory matches

■ machine translation matches

■ concordance matches

You can thus refine the way you work with these matches, as you can choose what

translation fragments to apply, straight from the Editor. When you activate a segment,

Studio looks up the source segment in the translation providers configured with the project.

Start typing and matching results are offered to prefixes.

To set up translation providers for AutoSuggest, go to

Files > Options > AutoSuggest > Translation Memory and

Automated Translation.

Choose if machine translation match is inserted in
Editor

You now have the option to set the behavior for when a translation memory match is not

found. By default, when this happens and a machine translation provider is configured, the

MT match appears in the Translation Results window, but is not inserted in the active

target segment of the Editor. Instead, when you start typing in the target segment, you get

fragments of text from the MT match that you can apply to your translation or not. This

gives you a lot more control over the MT and decreases the time it takes for post-editing

MT matches.

You can choose whether the MT match is automatically inserted in the Editor using the

Apply automated translation when no TM match is found option found in

File > Options > Editor > Automation.

Contemporary look and feel for the User Interface

Studio 2015 has a refreshed user interface. The flat-style icon set and window look puts it

in line with the current Microsoft operating system and Office suite.

The UI refresh also brings with it minor tweaks in user experience, like the new options

to change how the Ribbon is displayed. In addition, to enhance usability, the Add as New

Translation button was moved from the Advanced tab to the Confirm split button on

theHome tab. The Lookup Translations command from the Translation Memory group

on the Advanced tab was moved to the Segment Actions group on the Advanced tab.

What's new in SDL Trados Studio 2015?
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Personalize the Ribbon interface with your
preferred commands

The Ribbon interface is now customizable, allowing you to set up custom tabs and groups

and add your preferred commands to those groups. You can add custom groups to default

or custom tabs, and populate them with your preferred commands. You can also add

custom commands to the Quick Access Toolbar. All changes you make to the ribbon can

be reset to default.

The new options are available from the View tab > User Interface group > Ribbon

Customization.

Leverage any TM, regardless of it matching
languages with your project

With the newAnyTM provider options, Studio can now add any file or server-based

translation memories to a project, even if the source and target languages of the TMs do

not match those of the project’s. You can also work with TMs in reverse language direction.

For example, you can translate a German (Germany) > English (UK) project using an

English (UK) > German (Germany) TM.

To work with TMs that do not match your project's languages use the AnyTM options

from the Translation Memory and Automated Translation page.

AnyTM also allows you to translate documents that contain text in more than one different

language. For example, translate a document with English, French and Dutch content

into German. Studio handles this type of document and automatically leverages and

updates the appropriate TM depending on the language of the segment being translated.

For more information, see the Using any TM Online Help resource.

The SDLAutomated Translation provider is no longer available in the Add TM list as

this engine provider has been retired in favor of more recent options such as SDLLanguage

Cloud.

Create bookmarks and quickly jump to preferred
segments

You can add custom bookmarks with notes in any document. Studio can automatically

track the segment you were last translating in a document or project. Also, when opening

a document, Studio can automatically jump to the last accessed segment.

What's new in SDL Trados Studio 2015?
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Quickly insert special characters and symbols in
the Editor

Insert special characters and symbols straight into the translation Editor from the Ribbon

UI.

Go to the Advanced tab and click Insert symbol. Choose from the available characters

found in the dialog box and click the Insert button.

New Microsoft Word File Type

The new Microsoft Word 2007-20016 file type launched with Studio 2015 as a technical

preview alongside the legacy Microsoft Word file type is now production ready. The new

file type, designed with robustness and performance in mind, can now be use in

production projects. However, it is not the default file type in this release - the legacy file

type is still used by default to allow you to finish ongoing projects without disruption.

Key enhancements in the new Microsoft Word file type include:

■ Support for Microsoft Word documents exported from Google Docs, LibreOffice

or other providers.

■ Added the ability to save target files despite tagging issues. Users can now decide

what should happen when errors had been introduced to internal tagging within

the target sentences:

■ Use source segment content will copy the source sentence with all

tagging into the target file

■ Continue with errors will skip saving this particular target segment but

will be able to continue with the next one with no permanent error blocking

the user from saving the target file

■ Stop processing will behave like the legacy Microsoft Word file type,

show an error message and not save the target file.

■ Completely redesigned handling of WordArt .

■ Completely redesigned handling of content controls . This will help customers

who rely on this type of highly structured documents, such as law firms or other

legal bodies.

■ Enhanced support and more robustness for RTL languages such as Hebrew and

Arabic.

■ Enhanced handling of advanced character formatting for outline and other

character styles.

■ Simplified handling of hyperlinks.

■ Simplified handling of comments. The new default is now that of extracting the

document's comments as Studio comments.

What's new in SDL Trados Studio 2015?
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Due to the changes in handling comments, we recommend you to reset the Word

2007-2016 file type settings to default after you upgrade to Studio Service Release 1. To

do this, go to File > Options > Microsoft Word 2007 - 2016 > Common

and press Reset to Default.

PDF file type enhancements

The PDF file type has been enhanced with the addition of optical character recognition

(OCR) capabilities. This now makes it possible to open and process scanned PDF

documents.

Added support for bilingual Excel files

Studio 2015 can now process Microsoft Excel files where the source and target text is

organized in the columns of a spreadsheet.

The new Bilingual Excel file type can also handle additional columns that contain

reference information such as translation context and comments. Studio will display these

as Document Structure Information once the content of the spreadsheet is open for

translation in the Editor view.

You can also use the new filter for translating spreadsheets that contain multiple target

languages. For more information, see Working with multilingual Excel files .

To configure what the new file type extracts for translation from bilingual Excel files, go

to File > Options > Bilingual Excel.

The Bilingual Excel file type supports any files created in Excel 2007 and later. Studio

can process Excel files even if you do not have Microsoft Office installed on your

computer.

Exclude locked segments from the Analyze Files
batch task

You can now improve analysis speed for files with a lot of PerfectMatches or with locked

100% and context matches by skipping locked segments from the active analysis.

Find this option by navigating to File > Options > Language Pairs > All

Language Pairs > Batch Processing > Analyze Files.

What's new in SDL Trados Studio 2015?
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Enhanced word count and search logic for words
containing hyphens and dashes

Following the improvements to the algorithm used for processing words with hyphens

and apostrophes from Studio 2014 SP2, the word count behavior and matching logic has

changed.

Word count

Studio 2015 introduces new options to define the word count behavior for words

separated by hyphens, dashes, formatting tags or apostrophes. Find these options in

the Fields and Settings section when adding or changing settings for a translation

memory. Also, a new hyphen character was added to the list of separating or joining

characters: minus sign −.

Matching algorithm

To decide if there is a context match or not when searching in the selected TMs,

Studio compares the number of recognized tokens of the surrounding segments from

the source and the suggested target. The new logic for counting and matching can

therefore affect how a TM recognizes tokens and this may invalidate context matches

if you change counting behaviour. Against this background, SDL recommends that

you run thorough tests on your translation projects before making changes to the word

counting.

Important: Re-index your existing TMs before using them in Studio 2015 with the

new options. This synchronizes the TMs with the new logic for counting and matching

words.

New shortcuts for the options in File Menu

Use the new shortcuts for opening projects, files or TMs. You can also find these shortcuts

next to the options when navigating to File > Open:

Open Package Ctrl+Alt+K

Open Project Ctrl+O

Open GroupShare Project Ctrl+Alt+G

Translate Single

Document

Ctrl+Shift+O

Open Translation Memory Alt+Shift+O

Open Alignment Ctrl+Shift+A

Open Retrofit File Alt+Shift+R

What's new in SDL Trados Studio 2015?
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Include only relevant resources when creating a
project package

When creating project packages, Studio takes into account the language pair level and

only includes file-based resources (translation memories orAutoSuggest dictionaries)

relevant to that language pair.

Integration API: Access and update segment and
paragraph properties

New methods exposed in the Integration API allow third-party developers to:

■ update the content of segments

■ update paragraph and segment properties

■ update paragraph and segment metadata

All changes are documented in the SDK.

Added several file types to Studio

Several file type definitions are now added by default to SDL Trados Studio. These allow

you to localize the following file types:

■ MadCap Flare files

■ Files created in the Kilgray MemoQ tool

■ Portable Object (PO) files

■ SubRip (subtitling) files

■ AuthorIT XML files

These file types are now listed under File Types in the project settings and under

File > Options > File Types.

Robust licensing system

This release extends the licensing system based on third-party technology from SafeNet

to all product activation methods, including single user activation. The new licensing

mechanism provides an enhanced licensing robustness for a wide range of different

network topologies. It also improves your licensing workflow to ensure more flexible

deployments in networks and distributed scenarios.

Studio has discontinued support for the Nalpeiron-based licensing system for both

single-user activation and network licenses.

What's new in SDL Trados Studio 2015?
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For information on using the new network licensing technology, contact SDL Support:

■ If you have a Support and Maintenance contract, go to your SDLAccount and log

a support request via Support & Education > Support.

■ If you do not have a Support and Maintenance contract, go to the Knowledge

Base and log your request via Solution Finder > Licensing

Problems > I use SDL Trados Studio 2015.

What's new in SDL Trados Studio 2015?
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Chapter 3

Resolved issues
SDL Trados Studio 2015 was updated with two service releases that improve on some of

the features of the initial 2015 release. You can find the list of fixes and enhancements in

this section.

SDL Trados Studio 2015 SR2 contains the changes of all the previous service releases

and cumulative updates. Future hotfixes will be described in the Cumulative Updates for

SDL Trados Studio 2015 SR2 Knowledge Base article.

Issues resolved in Studio 2015 SR2
A list of issues that were resolved in SDL Trados Studio 2015 SR2.

Improved the Analyse Files batch task

The following issues regarding the Analyse Files batch task were addressed:

■ The analysis results now also include fuzzy matches with the minimum match

value. These were previously excluded from the results.

■ Analysis results no longer differ during and after project creation when files

are sorted differently in the Files View. The analysis now always uses

alphabetical sorting internally.

Enhancements to processing white spaces when using Japanese as a target language

As a general rule and as before, a space at the end of the segment is removed. However,

a space is added or kept after the following characters: single-byte colon, semi-colon,

question mark or exclamation mark. Studio makes sure that the space between the

segments is kept after these characters.
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Improved working with server-based GroupShare TMs in Studio

These are fixes and enhancements related to working with server-based translation

memories in Studio:

■ Users with Guest role (or any roles with only view permissions) were able to

open server based TMs for maintenance and edit translation units. This was

changed in accordance to their permissions, so they can now still open TMs for

maintenance, but they cannot not edit TUs.

■ An Object reference not set to an instance of an object error was thrown when

clicking on the scroll bar in the Server-Based Translation Memory dialog

box. This is now fixed.

Fixed several issues with opening project packages

There were several issues with the Open Package wizard:

■ The Could not find file "..\path\filename" error was displayed when opening

certain SDLWorldServer packages. This was now fixed.

■ An error was thrown when importing certain SDLWorldServer packages

containing termbases in Studio and the path for termbase was not found. This

is now fixed.

■ Fixed an error occurring when importing certain TBX terminology files on the

fly as part of SDLWorldServer package conversion.

Addressed several Bilingual Excel File Type issues

There were two issues with the Bilingual Excel file type:

■ The The attribute 'copies' has invalid value '0' error was displayed when

opening certain bilingual Microsoft Excel files in Studio. This is now fixed.

■ The The attribute 'horizontalDpi' has invalid value '0’ error was displayed

when opening the certain bilingual Microsoft Excel files in Studio. This is now

fixed.

Addressed several Adobe InDesign IDMLFile Type issues

There enhancements were made to the InDesign IDML file type:

■ New reading order for column-based layouts: if detected, the reading order is

automatically changed to top-left to bottom-right by rows and reading is done

from top-left to bottom-right by columns.

■ Certain cross reference formats in the file caused error messages when saving

target files. This is now fixed.

Addressed several Adobe FrameMaker 8-13 MIF File Type issues

There were several issues with the Adobe FrameMaker 8-13 MIF file type:

■ The startIndex cannot be larger than length of string. Parameter name:

startIndex error was thrown when opening MIF documents. This is now fixed.

■ The changed order of Cross References was not preserved in the target file.

This is now fixed.

■ Sub-langauge information was not written for Chinese languages in target

MIF file. This is now fixed.

Resolved issues
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■ Text Insets caused text not to be imported for translation. This is now fixed.

■ Square brackets in marker text were double escaped with backslashes in the

target file. This is now fixed.

■ Check mark was not recognized as a tag but a number. This is now fixed.

Addressed several XML and HTMLFile Types issues

There were several issues with the XML file type:

■ If the encoding was not manually specified, the XML files could be processed

with the wrong encoding. To prevent this, the defaults have changed: if the

XML file has no XML declaration or no byte order mark (BOM), Studio will

automatically process it as UTF-8. The encoding can still be changed by

specifying it before opening the file in Studio.

■ If you disabled the Entity Conversion option, the Advanced options from

XML Entities was unaccessible. This is now fixed.

■ A Stack empty error was thrown when opening a file with combining long

stroke overlay character. This is now fixed.

There was also an issue affecting both the XML and the HTML file types with Studio

not re-encoding numeric entities in the target, but keeping them in a character

reference form. This is now fixed.

Addressed QuarkXPress Type issue

An incorrect error message when trying to open XTG file for translation in Studio

was thrown. This is now fixed.

Miscellaneous fixed issues

These issues were also fixed with SDL Trados Studio 2015 SR2:

■ Several fixes to localised user interfaces.

■ Localized Getting Started videos were added for French and German.

■ Fixed an issue in the SDL Plugin installer where it was not displaying

information correctly on 4K/high DPI screens.

■ The reports created from the Update TM batch tasks now include the setting

specified for the If target segments differ option

Resolved issues
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Issues resolved in Studio 2015 SR1
A list of issues that were resolved in SDL Trados Studio 2015 Service Release 1.

Fixed several AutoSuggest issues

There were several issues with AutoSuggest:

■ Using AutoSuggest, if you deleted a target segment while holding the Backsp

ace key pressed, the Parameter name: StartIndex error was thrown. This is

now fixed.

■ Fast typing the second letter of a word was stalling AutoSuggest meaning it

would stop giving suggestions. This is now fixed, which also means that

AutoSuggest no longer interferes with third-party products such as dictation

software.

Fixed several AutoCorrect issues

There were several issues with AutoCorrect:

■ Pressing the End, Home, Page Up and Page Down keys was unexpectedly tri
ggering AutoCorrect quotes. This is now fixed.

■ The cursor jumped unexpectedly when deleting characters behind an

apostrophe or when using AutoSuggest suggestions. This is now fixed.

■ Using the Copy Source to Target option, straight quotes were changed to

smart quotes. This is now fixed.

Fixed several TQA issues

There were several issues with Translation Quality Assessment:

■ When all Penalties values were set to 0 the Object Reference not set to an

instance of an object error was thrown. This issue was fixed.

■ TQA reports used to calculate incorrect total penalty points when text

replacements (additions/deletions) existed in the file. The penalty point are

now correctly calculated.

Working with terminology issues

There were several issues with terminology in Studio that are now fixed:

■ Terms are now added to corresponding sub-language in termbase.

■ Using the Quick Add New Term option no longer goes into a loop when

mandatory fields are not filled.

Auto-propageted segments lead to duplicate TUs when updating TMs

Editing and confirming auto-propagated segments was creating duplicate translation

units. This is now fixed.

Addressed XLIFF File Type issue

If the source XLIFF contained empty source tags, Studio generated an invalid target

language XLIFF. This is now fixed.

Resolved issues
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Addressed several Bilingual Excel File Type issues

There were several issues with the Bilingual Excel file type:

■ Empty cells in the source column cause the translation in the target to move a

row higher.

■ Segment status is no longer confirmed when the cell in the translation column

is empty.

Addressed Microsoft PowerPoint 2007-2013 File Type issue

Microsoft PowerPoint PPTX files are no longer saved out with all text formatted in

the source language, making it impossible to run spell check on the target file.

Addressed Microsoft Word File Type issue

Fixed the No context information exists error when opening specific files.

Addressed HTMLFile Type issue

All the attribute values following lang are no longer changed to match the target

language rather than keeping the attribute value.

Addressed XMLFile Type issue

Extra spaces are no longer added unexpectedly at the end of paragraphs in the target

file if the source language is Japanese or Chinese.

Miscellaneous fixed issues

These issues were also fixed with SR1:

■ Fixed several issues related to Retrofit.

■ Files could not be checked into GroupShare after splitting segments. Fixing

this also eliminated the related Confirmation statistics word count is greater

than the total number of words error.

■ Formatting added with QuickPlace included whitespace after the word selected

by double-click. This no longer happens.

■ After activating the option to use regular expressions, the Find function for

plain text was not working correctly. This is now fixed.

■ Fixed the Multiple placeholder tags with the same ID having different tag

properties error.

■ When trying to change the password of a GS account from Studio an error

was thrown. This is now fixed.

■ When the content of custom text fields exceeded 1680 values, the generic

error occurred in GDI+ error was thrown. This is no longer happening.

■ Several project translation memories were not populated in multilingual

projects. This is now fixed.

■ Tag colors are not saved.

■ You could not select the last word properly in certain cases for mixed BiDi /

English text. This is now fixed.

Resolved issues

21SDL Trados Studio 2015 SR2



Issues resolved in Studio 2015
A list of issues that were resolved in SDL Trados Studio 2015.

Term recognition now works more reliably in long segments

The 255 character limit was lifted and now the Term Recognition window returns

searches for terms found toward the end of a long segment.

Update Main Translation Memories without issues

Awarning message displayed after the Update Main Translation Memories batch

task was run. This was fixed.

Fixed issues with batch updating TMs

An error was thrown when using the Update Main Translation Memories batch task

to import translation units with custom fields that are not set in the translation memory

to be updated. This issue no longer exists and the unknown fields are not added to the

TM.

Fixed issues with comments in a virtually merged file

Adding a file comment to a virtually merged file lead to the comment being lost when

closing the merged file. You can now only add segment level comments to the

virtually merged files, but these comments will be saved into the individual files they

belong to, even after closing the merged file.

Added consistency for navigating between segments

Pressing CTRL + UP now navigates to the previous untranslated segment and ignores lo
cked segments.

Fixed virtually merged files if one of them has no file type

An error was thrown when opening an SDLXLIFF file without file type together with

a file with a file type. This now works without issues.

Improved navigating to an error

Clicking an error message now highlights the segment that the error is referring to and

displays it in the middle of the page, not at the top. This now makes it easier to read.

Fixed verifying files with segments that contain only tags

Running the verification task if you have segments that contain only tags and if the

Check for possible non-usage of the target terms option is enabled now works

without error messages.

Fixed auto-propagation issues

Auto-propagation did not work for segments that contain Variables. This now works

without issues.

Fixed incorrect Analyze report

The Analyze Files report did not contain all fuzzy matches, when creating a project,

if you change the order of a task sequence to initiate the Analyze Files task before the

Pre-translate Files task. This now works without issues.

Resolved issues
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Fixed issues with the Save as function

The Save as function did not save the correct version of the file when the file was

saved in another location. This is now fixed.

Fixed error when creating a project package

The Index out of range. Must be non-negative and less than the size of the collection

error was displayed if you created a project package from a project with several

translation memories for All Language Pairs and one of the languages had the Use

different translation providers for this language pair option enabled in the project

settings. This now works without issues.

Addressed XLIFF File Type issue with <sub> element

The <sub> element was not preserved when it was the only child of a <ph> tag

without any text. This is now fixed.

Addressed several SubRip File Type issues

There were several issues with the SubRip file type:

■ When automatic line length processing was enabled and you opened an *.srt

file then saved it as target, extra space was added to the start of some segments.

■ Files with empty lines caused issues.

■ Not all types of line breaks in files were supported.

These are now fixed.

Addressed Adobe FrameMaker 8-13 MIF File Type issue

Variables at the end of a segment were moved to a separate segment if formatting is

applied to them. This is now fixed.

Addressed Embedded Content Processors issue

You can now add formatting to the target file when using HTML Embedded Content

Processor even if it was not present in the source.

Resolved issues
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Chapter 4

Known issues
The table below lists the limitations associated with the 2015 release of SDL Trados

Studio.

These are the issues that SDL considers important to resolve, but not serious enough to

delay the Studio 2015 SR2 release. The development team will prioritize these issues in a

future Studio release.

After updating to Service Release 2, the network-licensed Studio cannot connect to

the license server

If you use a Studio instance that is connected to an SDL License Server which contains

multiple product editions, you will find that the first time that you open Studio after

updating to Service Release 2, the Product Activation window displays that you are

disconnected from the server. This is because the possibility to choose from multiple

product editions from a network license was introduced in Studio 2015 SR2 and you

need to let Studio know what edition to choose after you update to this version.

1. On the displayed Product Activation page, click the Change License Server link.

2. On the page where you set the license server name, click Connect.

25SDL Trados Studio 2015 SR2



3. Choose the Studio edition and click Connect.

4. Click Continue.

For more information, you can check the 9317 Knowledge Base article .

A fix for the Bilingual Excel file type in Service Release 1 might lead to impossibility

to save files

If you are using Studio with a localized user interface, we recommend that you first

complete all projects that are using the Bilingual Excel filter and then update to Service

Release 1. If you update to SR 1 before completing the projects, you might not be

able to save the translated files.

Ribbon customization limitations

In the Customize Ribbon dialog box, you can add new tabs and groups, and move

them around to change their display order on the ribbon. Currently, this imposes the

following limitations:

■ you cannot move the default Home, View, Add-ins or Help tabs. Similarly,

you cannot move the groups or actions that these default tabs contain.

■ you cannot move custom groups within the default tabs. This means that

inside default tabs, you can only add custom groups at the top of the existing

ones. On the ribbon, these will appear on the left hand-side of existing groups.

However, within your own tabs, you can freely move your custom groups.

■ you cannot add a number of dynamic, context-dependent commands. For

example, some Formatting, QuickInsert and Review actions like adding

comments may depend on the type of file to which you will apply these actions.

Therefore, these dynamic actions cannot be made available for ribbon or

quick access toolbar customization.

License Server Manager only supports individual sessions

When you deactivate a Studio network license, SDL License Server Manager requires

a restart before allowing you to deactivate a different SDL product.

Different instances of SDL License Server Manager for Studio 2015 and Studio 2014

Because changes were made to the network licensing system in Studio 2015, you

cannot use the same License Server Manager instance to run licenses for both Studio

2015 and Studio 2014. You will need to use two servers each with its own License

Server Manager instance.

TM re-indexing required for applying latest changes to recognized tokens

Studio 2015 includes some changes related to recognized tokens (also referred to as

placeables), for instance in the area of acronyms. To ensure optimum matching and

avoid creating duplicate translation units when you edit existing 100% matches, SDL

recommends that you re-index all your TMs to recalculate all recognized tokens.

To re-index translation memories:

1. Select Translation Memories view and open your translation memory.

2. Click Home tab and select Settings under the Tasks group.

3. Under Performance and Tunning, select Re-index Translation Memory.
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Wait for the process to finish as this may take a while. If for any reason you are still

seeing matching issues and/or unwanted translation unit duplicates, consider

exporting/importing the translation units into a new TM.

Limited number of languages for OCR capability

Optical Character Recognition (OCR) capabilities in the Studio 2015 PDF file type

are limited to 14 languages at this stage. Asian languages are not supported. For more

information, see http://www.soliddocuments.com/solid-ocr.htm .

Preview function for segments with embedded content not working

The Preview function in the Editor view does not currently work when you select

segment text that meets your definition settings for embedded content inside an XML

document.

Unknown fields are not added to the TM when batch updating translation memories

Using the Update Main Translation Memories batch task to import translation units

with custom fields that are not set in the translation memory to be updated, leads to

those fields being ignored.

Any changed target segment content is applied. When the custom fields exist in the

TM, they will get updated.

Focus jumps in Editor when opening a large document

When opening large documents, if the Automatically jump to the most recent

segment when opening a document option is enabled in Bookmarks settings, the

focus can sometimes jump inside to a random segment inside the Editor.

Large fonts lead to text display issues

Increasing the font size on your computer may truncate the text inside some dialog

boxes.

AutoCorrect - limited support for Asian and right-to-left languages

Currently, AutoCorrect has limited support for Asian and right-to-left languages. SDL

plans to enhance this area in a future release.

Adding files to a single-file project

Adding new files to a Single-File project corrupts the project and Studio may be

unable to open the project at a later stage. If you want to add additional files after

creating a project, create a Standard Studio project instead.

Limited Studio editions on domain-based networks

When you try to run the Freelance or Starter version of Studio on a domain-based

network, Studio informs you that you cannot run these versions on such a network.

This is by design and does not occur on workgroup-based networks or stand-alone

computers.

Segment-level comments break saving documents

When adding segment-level comments on segments that contain tags, you may not be

able to save document as target for *.docx files . Test Saving Target As after adding

the comment to see if this happens, then consider changing the comment in such a way

that it is a segment range comment rather than a segment-level comment.
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Auto-propagation changes dashes to hyphens

En or Em dash characters may change to hyphen characters when you translate

numbers with dashes during auto-propagation.

Alignment issue - Failing to import TUs with multiple values for a field

Import fails if the TM has source or target file fields defined with the Allow Multiple

Values property. In this case, Studio shows the error No alignment pairs matched your

TM import options.

Known issues
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Chapter 5

Installing Studio
This section contains general information on installing Studio 2015 SR2 and the technical

requirements for the installation.

For step-by-step instructions on how to install and maintain Studio, see the Studio

Installation guide .

Installation prerequisites

Hardware
■ AMicrosoft Windows-based PC or an Intel-based Apple Mac computers running

Windows as an operating system

■ Up to 2.5 GB of available disk space to run the Studio installer

■ 2 GB of available disk space to run Studio

■ A 32-bit (x86) or 64-bit (x64) processor

■ 32-bit (x86) OS

■ 1 gigahertz (GHz) or faster processor

■ 2 GB RAM

■ A screen resolution of 1280x1024 pixels and 256 colors or higher

■ 64-bit (x64) OS

■ A recent processor with dual or multi-core technology

■ 4 GB RAM

■ A screen resolution higher than 1280x1024 pixels
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Operating Systems

Supported OS

■ Studio 2015 SR2 runs on the latest build of Windows 10, the latest updated

version of Windows 8.1 and the latest service-packed version of Windows 7.

■ Studio also supports Windows Server 2012 R2 and Windows Server 2008 R2 to

facilitate certain scenarios, for example, where Citrix or Remote Desktop Services

are used.

Unsupported OS

■ Studio 2015 SR2 has dropped support for Windows 8.

■ Studio 2015 has dropped support for Windows Vista.

■ Studio does not support earlier operating systems such as Windows XP and

Windows 2003 Server.

Recommended OS

SDL recommends that you use the same operating system as the other users with whom

you are sharing packages. This is because the number of supported languages can vary

depending on the operating system used.

Software
■ Studio 2015 SR2 requires Microsoft Office 2013, 2010 or 2007 for previewing

documents and Microsoft Word for spell checking. Studio 2015 SR2 fully supports

all Microsoft Office 2007-2016 and 2000-2003 file formats.

■ For processing RTF and PDF files, Studio requires Microsoft Word 2003 or

higher. If you are using the real-time preview feature, SDL recommends that you

use Microsoft 2013, 2010 or 2007 as Word 2003 may cause certain issues. You can

find potential workarounds in the SDL Knowledge Base .

■ For Microsoft Excel 2000-2003, Studio uses a processor to convert to Excel 2007

and back. For this to work correctly, install the Microsoft 2007 compatibility

pack from the Microsoft Download Centre .

■ If you are using Excel 2000 or 2002/XP, save your *.xls files to the more recent

*.xlsx format, as Studio may not be able to do this automatically. First save your

*.xls files as .*xlsx in Excel 2000 or 2002/XP, then open the files in Studio and

translate them as *.xlsx. After translation, use Excel to save the *.xlsx files as

*.xls again.

Installing Studio
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Browsers
■ To display the Studio online Help, make sure you are using Microsoft Internet

Explorer 7 or later.

■ If you access the Help directly in a browser instead of clicking the Help button

inside Studio, you can also use Mozilla Firefox 3 and above, Safari 4 or any version

of Google Chrome.

Installing and upgrading

Studio 2015 SR2 installation

You can download the Studio installer from your SDLAccount.

When installing Studio, make sure that you have administrator rights and that no other

software is running.

Studio 2015 SR2 installs side-by-side with previous major versions of Studio. However,

as a service release for Studio 2015, Studio 2015 SR2 installs on top of previous Studio

2015 versions and cannot run alongside them.

You can find a full list of the software, including third-party software installed with

Studio in the Studio 2015 Installation Guide .

Studio 2015 SR2 upgrade

When you upgrade from Studio 2014, Studio 2015 SR2 keeps all the configurations set in

your 2014 version. If you plan to install and use Studio 2014 and Studio 2015 SR2

side-by-side, install Studio 2014 first.

If you are using a license server, after upgrading, you need to connect to a license server

with SDL License Server Manager 2015 installed.

See the SDL Knowledge Base for the latest information on installation and upgrade

issues.

Installing Studio
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Chapter 6

Licensing Studio
This section contains information on special requirements for licensing certain Studio

versions.

For detailed instructions on how to activate single and network Studio licenses, see the

SDL Licensing online Help .

Licensing Studio 2015 SR2 from Studio
2014/2011

Studio 2015 uses a new type of activation code. After upgrading from Studio 2014/2011

to Studio 2015 SR2, your original license will be automatically removed from your

account. To continue using an older version, you should consider purchasing a full license

instead of an upgrade.

If you have a Studio Freelance Edition, you can continue to use Studio 2014/2011

alongside Studio 2015 SR2 on the same machine until you deactivate the older product's

license.

If you want to try Studio 2015 SR2 side-by-side with Studio 2014/2011, you can use the

30-day trial that is available in Studio 2015 SR2.

Licensing Studio 2015 SR2 from Studio 2015
If you have a Studio 2015 license, you can upgrade to Studio 2015 SR2 for free. As a

service release for Studio 2015, Studio 2015 SR2 shares the same activation code.
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Licensing Studio 2015 SR2 using a network
license

Starting with SDL Trados Studio 2015, SDL dropped support for the Nalpeiron network

licensing technology. Studio 2015 SR2 only uses licensing technology based on SafeNet

network licensing. You can activate Studio 2015 SR2 network licenses using the 2015

version of SDL License Server Manager.

Mixed 2014-2015 scenarios

SDL License Server Manager 2015 cannot run network licenses for both Studio 2015

SR2 and Studio 2014. Separate servers are required for handling activations of these two

Studio versions. Install SDL License Server Manager 2014 on the computer that will

handle 2014 activations, then install SafeNet 2015 on a separate computer that will deal

with 2015 activations.

If you need to activate both Studio versions from the same server, you can use the

Nalpeiron Licensing Server Toolkit in conjunction with SDL License Server Manager

2015. Nalpeiron will handle any queries for activating Studio 2014 while SDL License

Server Manager 2015 will handle activation calls for Studio 2015 SR2.

However, SDL recommends that you migrate away from using the legacy Nalpeiron

Licensing Server Toolkit in the near future. Ideally, move to a clean environment with

just Studio 2015 SR2 and a SafeNet network license, as this is the most robust and

future-proof solution.

Contact your SDL representative for consultancy on the best option for your particular

deployment scenario.

Multiple product editions on a license server

Starting with SDL Trados Studio 2015 SR2, you can connect to a network license server

that has multiple product licenses active and choose what Studio edition to use. For more

information on how to connect to a license server, see the Online Help .

Licensing Studio
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Remote Desktop connections

When using a Remote Desktop Connection, you can run more than one instance of Studio

on the remote workstation; however, each instance will consume a network seat.

When using Remote Desktop Services or Citrix XenDesktop, you can only activate

Studio with a network license. Each user session consumes one network seat until all

available seats are exhausted.

Network-licensing when upgrading Studio
2011 to Studio 2015 SR2

If you are a Studio 2011 user upgrading to Studio 2015 SR2 in a network-licensing

scenario, install the new SDL License Server Manager to activate the Studio license. You

can continue to use Studio 2011 with network licensing using the legacy License Server

Toolkit.

Licensing Studio
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Chapter 7

Compatibility
This section lists the previous Studio versions that Studio 2015 is compatible with. It also

offers information on special compatibility with other important software.

Compatibility with previous Studio versions
Studio 2015 SR2 can run alongside previous versions of Studio. However, as a service

release for Studio 2015, Studio 2015 SR2 installs on top of previous Studio 2015 versions

and cannot run alongside it.

Studio 2011/Studio 2014

All versions of Studio 2015, Studio 2014 and Studio 2011 have the same project and

package format.

Studio 2015 SR2 automatically converts 2009 projects to Studio 2015 when you open

them for the first time in Studio 2015 SR2.

Studio 2009

Although Studio 2009 has reached End-of-Life and is no longer supported, you can send

translation packages back and forth between Studio 2009 SP3 and Studio 2015 SR2.

To create packages in Studio 2015 SR2 that you can open in Studio 2009 SP3, go to the

Projects view and select Home tab > Create Studio 2009 Project

Package.
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Embedded settings

Before creating Studio 2009 packages, make sure that your SDLXLIFF file type

settings embed the source files so that you can still edit file types that Studio 2009 does

not support.

To do this, set the embedding to 100 MB under File

Types > SDLXLIFF > General. SDL recommends that you change this setting

in the project template (or default template via File Menu > Options) before

creating the project.

Backwards compatibility

In Studio 2015, you can create, work and return Studio 2009 packages that include

INX, Java properties, PDF or Open Office files. You can also upgrade these to Studio

2015 format. However, you cannot save as target or preview such files. This is

because Studio 2015 uses later versions of these file types that are not backward

compatible for previewing or saving as target.

Side-by-side installations

SDL recommends that you keep both Studio 2009 and Studio 2015 side-by-side so

that you can flexibly plug into the different supply chains as required. Also, make sure

to finish ongoing projects in the version in which they were created. This means it is

better to complete projects in Studio 2009 before switching to Studio 2015.

SDL Trados 2007

You can also install Studio 2015 SR2 alongside SDL Trados 2007.

Studio 2015 SR2 also contains its own version of the SDL Trados 2007 infrastructure so

all use cases that require SDL Trados 2007 still work even if you do not have SDL Trados

2007 installed.

Backward compatibility

Studio 2015 SR2 supports the following:

■ S-Tagger

■ ITD

■ TTX

■ Upgrading TMW

■ Upgrading MDB

For extensive information on backward compatibility and upgrading TMs, see to the

online Help and the Studio 2015 Migration Guide , available in theWelcome view >

MORE RESOURCES tab.

Compatibility
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New features compatibility

If you use the new features included in Studio 2015 (i.e. Translation Quality Assessment),

make sure that your entire supply chain uses the same software version. Exchanging

projects or project packages that use the new features between Studio 2015 and earlier

software versions can lead to issues.

Compatibility with other software
SDL Passolo

Studio 2015 SR2 is compatible with SDL Passolo 2011 SP9 and SDL Passolo 2015.

MultiTerm (Desktop)

You can use both MultiTerm 2014 and MultiTerm 2015 SR2 on the same computer as

Studio 2015 SR2.

SDL recommends that you use MultiTerm 2014 SP2 or MultiTerm 2015 SR2 to make

full use of the new Java-less terminology editing.

SDL server software

Studio 2015 SR2 is compatible with all versions of GroupShare 2015 and GroupShare

2014 (TM Server, MultiTerm Server and Project Server) as well as GroupShare 2011

for Oracle.

SDL enterprise software

Studio 2015 SR2 is compatible with all bilingual files and packages created in any

version of:

■ SDLWorldServer 9.x, 10.x and 11.x

■ SDL TMS 2011 SP6 CU1 and SDL TMS 11.x

SDL TMS and Studio extraction settings

SDL guarantees that within two months of a Studio release (major version or service

pack), SDLTMS will update its Filters to synchronize with SDLTMS. Currently, SDL

TMS does not include an auto-update feature to immediately match the changes that

Studio makes to its File Types via Cumulative Updates. This means that sometimes you

may find differences between file content extracted as translatable text in Studio and

in SDL TMS. To ensure full compatibility between Studio and SDL TMS, SDL

recommends that you use the version of Studio that contains the same set of File Types

as your SDL TMS. You can also manually configure the SDL TMS Content Types

settings to synchronize the content extraction logic.

For more information on which version of Studio is in line with SDL TMS, contact

SDL Support or check the SDL TMS release notes.

Adobe InDesign and InCopy

Studio supports the CC and earlier versions of Adobe InDesign and InCopy. CC is the

current version of Adobe InDesign and InCopy at the time of the 2015 SR2 release

of Studio.

Compatibility
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If Adobe releases new versions of InDesign and InCopy following the Studio 2015

SR2 release, SDL may implement support for these through another service release or

through a cumulative update. Until then, you can use the Process unsupported file

versions option in Studio to open any IDML and ICML files. This option enables

compatibility for files created in higher Adobe versions than the one available at the

time of the last Studio update.

This option is available on the Common page of these two File Types settings.

Adobe FrameMaker

Studio 2015 supports Adobe FrameMaker 8.x, 9.x, 10.x, 11.x, 12.x and 13.x (released

as FrameMaker 2015).

Compatibility

40 SDL Trados Studio 2015 SR2



Chapter 8

Supported Releases
Studio 2015 is the active release of Studio. SDL continues to support Studio 2014 as the

mature release. However, following the release of Studio 2015, SDL has moved Studio

2011 to a retired state.

SDL does not provide technical assistance, issue service packs or hotfixes for retired

releases. For Studio 2015, SDL will release service packs as and when required.

Limited support
The following filters benefit from limited support (no new feature development):

■ Word binary *.doc

■ PowerPoint *.ppt

SDL will reassess this in the next major release of Studio to offer a potential alternative.
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Chapter 9

Localization
The user interface and online Help for Studio 2015 is available in the following languages:

■ German

■ French

■ Spanish

■ Japanese

■ Simplified Chinese

■ Italian (user interface only)

■ Russian (user interface only)

■ Korean (user interface only, coming soon after initial 2015 release)
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Chapter 10

Further information
This section lists the resources available for getting more help and information on Studio.

Help
Studio Help

The online Help for Studio 2015 is available from the Help tab > Help Topics in

Studio. You can also go to the SDL Documentation Center to access the Studio online

Help. Here you can find links to:

■ Information on installing and upgrading toStudio 2015

■ Videos and information on how to get started with Studio

■ Help topics about working with Studio and GroupShare projects

GroupShare Help

If you are working with GroupShare projects, you may also find the GroupShare

online Help useful. Here you can find links to:

■ Information on installing and upgrading GroupShare 2015

■ Help topics describing how to work with GroupShare

MultiTerm Help

See the MultiTerm online Help for more information on working with termbases.

Contacting the Technical Support team
See SDL Language Technologies Support for information on how to get technical support.
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Appendix A

Acknowledgments
SDL Trados Studio includes open source or similar third-party software.

#ziplib

#ziplib (SharpZipLib, formerly NZipLib) is a Zip, GZip, Tar and BZip2 library

written entirely in C# for the .NET platform. It is implemented as an assembly

(installable in the GAC), and thus can easily be incorporated into other projects (in

any .NET language).

Apache log4net

The Apache log4net library is a tool to help the programmer output log statements to

a variety of output targets. log4net is a port of the Apache log4j™ framework to the

Microsoft® .NET runtime.

Hunspell

Hunspell is the spell checker of LibreOffice, OpenOffice.org, Mozilla Firefox 3 &

Thunderbird, Google Chrome, and it is also used by proprietary software packages, like

Mac OS X, InDesign, MemoQ, Opera and SDL Trados Studio.

ICU - International Components for Unicode

ICU is a mature, widely used set of C/C++ and Java libraries providing Unicode and

Globalization support for software applications. ICU is widely portable and gives

applications the same results on all platforms and between C/C++ and Java software.

SafeNet Sentinel

SafeNet's Sentinel software licensing products and software protection solutions

provides software publishers control and visibility into how their applications are

deployed and used.

Spring.NET

Spring.NET is an application framework that provides comprehensive infrastructural

support for developing enterprise .NET applications. It allows you to remove incidental

complexity when using the base class libraries makes best practices, such as test

driven development, easy practices.

WiX

The WiX toolset builds Windows installation packages from XML source code. The

toolset integrates seamlessly into build processes.
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Xerces-C++

Xerces-C++ is a validating XML parser written in a portable subset of C++.
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